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1.  Technical Support 
 
Technical support is available by e-mail.  Send your questions to MVOSupport@pa.wagner.com.  Your 
message will be acknowledged and an answer will be sent as soon as possible. 
 

2.  Introduction 
 
Thank you for purchasing M-V Optimizer, our Mean-Variance Portfolio Optimization package, designed to 
provide optimal portfolios in the Markowitz sense.  M-V Optimizer is based on specialized systems we have 
developed for securities traders and investment banks since 1994.  
 
M-V Optimizer is a Microsoft Excel-based application (either version 8 or above).  The flexible user 
interface is easy to use, while the core optimization is performed quickly and efficiently using a dynamic 
link library (DLL). M-V Optimizer is designed to handle up to 250 assets, and provides functionality for 
computing and displaying the entire efficient frontier, the optimal portfolio associated with a user-supplied 
target volatility, and the optimal portfolio associated with a user-supplied target return.  It handles both long 
and short positions, and provides a facility for specifying asset-specific minimum and maximum holding 
constraints.  The user is required to supply the expected return and volatility for each asset, and a 
correlation matrix.  Functionality is provided to calculate these some or all of these quantities using user-
provided time-series of returns for each asset. Asset holdings are measured as a proportion of the entire 
portfolio.  
 

3.  Installation Instructions 
 
M-V Optimizer can be installed using the following easy steps: 
 

1.  If you have an M-V Optimizer installation disk insert it into your floppy drive (say x:), or 
note the location of the M-V Optimizer installation file (MVSetup.exe)on your hard drive 
(say x:).  

2.  Click the Windows “Start” button.  
3.  Select “Run” in the “Start” button menu.  
4.  Type “x:\MVSetup.exe” in the Run dialog box, where x: is either your floppy drive or the 

path described in step 1 above.  
5.  Click the “OK” button.  

 
The installation program loads and prompts you for directory information.  You can accept all the defaults 
or choose different locations for loading the M-V Optimizer files.  When the installation is complete, 
remove the installation disk from your machine and put it away in a safe place.  If you don't have an 
installation disk, you can create one by copying the MVSetup.exe installation file to an empty formatted 



Daniel H. Wagner, Associates, Inc.  M-V Optimizer User’s Guide 

2 

floppy disk now.  If you ever need to recover the original M-V Optimizer files, simply run the install 
procedure again. 
 

4.  How to use M-V Optimizer 
 
M-V Optimizer is comprised of a Microsoft Excel spreadsheet user interface, a customized Excel add-in, 
and a DLL.  The DLL contains the core optimization engine, and the add-in provides the functional 
interface between the spreadsheet and the DLL.  Both the DLL and the add-in are designed for use with M-
V Optimizer only.  
 
To use M-V Optimizer, start Excel and open the Excel spreadsheet “MVOptimizer.xls” provided in the 
installation.  The spreadsheet opens to the "AboutMVOptimizer" sheet which contains license information 
and directions for use.  Click "Begin Free Trial" to start your 7-day free trial.  This will allow you to 
allocate portfolios among up to 10 asset classes, with no additional linear constraints.  Click "Activate 
License" to end your current free trial or a prior license activation, and initiate a new license activation 
sequence.  This will require you to send us a Site Code, and enter the Site Key we send you to activate your 
new license. 
 
The “Inputs” sheet allows you to specify the number of assets in your universe, the names of the assets, the 
minimum and maximum holding constraints for each asset, the expected reward for each asset, the volatility 
(standard deviation) for each asset, and the correlation matrix relating the assets to each other.  If you want 
to consider short sales for some of the assets in your portfolio, then set the minimum holding for those 
assets to a negative number; otherwise, set the minimum holding to zero or some positive number.  You can 
also specify a benchmark portfolio (such as your current allocation), only used for comparison purposes in 
the results sheets.  Once all your inputs are set, click the “Optimize Portfolio” button to generate the entire 
efficient frontier.  You can also navigate to the “Historical Returns” sheet where you can enter historical 
time-series returns and calculate your correlation matrix, volatilities, and/or expected returns.  You may find 
it easier to paste in your own correlation matrix on the “Review Correlations” sheet rather then typing it into 
the “Inputs” sheet because of the protected cells.  When you paste data from another sheet, select “Values” 
under “Paste Special...” in the Edit pulldown in order to preserve the cell formats in the M-V Optimizer 
spreadsheet.  This built-in Excel feature also allows you to “Transpose” data when you paste, which may be 
required if the layout of your time-series of returns is oriented assets (rows) by dates (columns) instead of 
the required dates (rows) by assets (columns). 
 
The "Define Constraints" button provides a separate input sheet for your constraints.  For each constraint, 
you need to specify the coefficient associated with each asset, an upper bound, and a lower bound.  Equality 
constraints have equal upper and lower bounds.  One-sided constraints have upper bounds set very large or 
lower bounds set very small.  Each constraint must have at least one nonzero coefficient.  Inconsistent 
constraints will produce errors.  Keep in mind that in M-V Optimizer, you always have the "sum of 
allocations equals 1" constraint enforced.  You can specify up to 125 constraints.  YOU MUST FIRST 
PURCHASE AN M-V OPTIMIZER PLUS LICENSE TO ENABLE THIS FEATURE.  ERROR CODE 222 
INDICATES YOU ARE SPECIFYING CONSTRAINTS WITHOUT AN M-V OPTIMIZER PLUS 
LICENSE.  Your copy of M-V Optimizer can be upgraded to M-V Optimizer Plus at any time. 
 
When the optimization is complete, the “FrontierGraph” sheet is displayed. This sheet displays the entire 
efficient frontier with the key breakpoints on the curve highlighted (these are the points where assets enter 
and exit the optimal portfolio).  At this point there are three options available:  return to the “Inputs” sheet 
and modify your problem (the “Input Sheet” button), display a graph of the Sharpe Ratio plot (the “Sharpe 
Ratio” button), or obtain optimal allocations for points on the frontier (the “Find Portfolios” button).  
 
The “FindPortfolio” sheet provides two useful functions.  The first function, “Find Reward and Portfolio”, 
allows you to enter your target volatility and obtain the portfolio which achieves the target volatility while 
maximizing the reward.  The second function, “Find Volatility and Portfolio”, allows you to enter your 
target reward and obtain the portfolio which achieves the target reward while minimizing the volatility of 
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the portfolio.  Your benchmark portfolio is displayed here for comparison purposes.  Again, the buttons at 
the top of the sheet allow you to easily move to other displays.  
 
M-V Optimizer also computes and displays the Sharpe Ratio, an alternate portfolio performance measure 
which produces the same efficient frontier.  This number is the excess return above the risk-free rate divided 
by the volatility, and can be interpreted as the risk premium return earned per unit of total risk.  
 
Please navigate using the pushbuttons on each page.  If you navigate using the tabs at the bottom of each 
worksheet, the required computations will not be done and you may see the leftover results of earlier 
optimizations.  
 
Saving the workbook (even with Excel's auto-save feature) overwrites the original version.  Your 
installation directory contains a read-only backup file called “MVOptimizerPlus-backup.xls” in case you 
need to restore the original.  You can also reinstall the software from your installation disk.  
 

5.  Enhancements, Products, and Services 
 
Daniel H. Wagner, Associates also offers additional portfolio optimization capability.  We can 
accommodate more asset classes, proportional transaction costs, general linear constraints, and covariance 
matrices based on factor models.  The cost depends on the features of interest, the size of your optimization 
problem, and the target platform.  We can support Windows 32-bit platforms and SunOS/Solaris systems.  
All versions of the software are designed to operate very quickly on large sets of assets.  
 
In addition to Mean-Variance Optimization, Daniel H. Wagner, Associates offers financial products and 
services for valuing interest rate derivatives, commodity derivatives, and equity options.  We also have a 
factor analysis package for constructing and manipulating the covariance matrix required by the portfolio 
optimization software, and forward rate curve generating software for supplying data to the interest rate 
derivative valuator.  
 
If your needs require more specialized functionality, contact us and see what we can do for you.  We are a 
company of mathematicians, with experience in mathematical finance and a variety of other operations 
research applications.  This experience combined with our software development capabilities can  
provide you with the functionality and performance you require.  
 

6.  Trouble-shooting M-V Optimizer Installations 
 
The MVOptimizerPlus.xls workbook contains macros written in Microsoft Visual Basic for Applications 
(VBA).  These macros are used to access additional VBA macros contained in the “Wagner Associates 
Investment Portfolio Optimization” add-in (MVOptim.xla), which in turn are used to access optimization 
functions in the MVOptim.dll dynamic-link library.  
 
Some Microsoft Office/Excel installations are not compatible with automatic referencing of the 
MVOptim.xla add-in.  If your installation of MVOptimizerPlus.xls fails to find any macros, please consult 
the following section corresponding to your version of Microsoft Office/Excel.  
 
 

Trouble-shooting Microsoft Excel Installations 
 
When opening MVOptimizerPlus.xls from Microsoft Excel Version 8, you might encounter a dialog box 
containing the warning: “The workbook you are opening contains macros.”  If this occurs, you must click 
the “Enable Macros” button on the dialog box, or you will not be able to use M-V Optimizer.  
 
At this point, Excel will attempt to locate the MVOptim.xla add-in.  If it is successfully located, you will see 
the Introduction worksheet, and may press either “START” button to begin defining your portfolio 
constraints.  Otherwise, the “Microsoft Visual Basic - MVOptimizerPlus.xls” window will appear, and the 
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following error dialog box will be displayed: “Compile error: Can't find project or library.”  You should 
click the “OK” button to proceed.  
 
Depending upon your Excel settings, you might now be presented with the “References - 
MVOptimizerPlus.xls” dialog box.  If not, you must execute the “Reset” command from the “Run” menu, 
and then you must execute the “References...” command from the “Tools” menu.  You now should see the  
“References - MVOptimizerPlus.xls” dialog box on your display.  
 
Click on the “MISSING: MVOptim.xla” line in the scroll box to highlight it, and then click the “Browse...” 
button.  First select “Microsoft Excel Files (*.xls,*.xla)” in the “Files of type:” pull-down.  Find the 
MVOptim.xla add-in, which should have been placed in the same folder as the MVOptimizerPlus.xls 
workbook.  Click on MVOptim.xla to highlight it, and click “Open” to proceed.  Click “OK” to save the 
updated reference.  
 
Now return to Excel by clicking the “x” button in the upper right corner of the “Microsoft Visual Basic - 
MVOptimizerPlus.xls” window.  You now should see the Introduction worksheet.  At this point you must 
execute the “Save” command from the “File” menu to avoid repeating this procedure each time you use  
M-V Optimizer.  
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